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Welcome to MAGic
MAGic is a software solution ideally suited for computer users with low
vision, or anyone who spends extended periods of time in front of a
computer screen.
MAGic lets you magnify your computer screen from 1 to 36 times its usual
size. You can choose from a number of different adjustable views that let
you see both a magnified and unmagnified portion of the screen at the
same time.
Speech features assist you in processing the information on your screen.
MAGic can read text that you type or point at with the mouse. MAGic
moves the magnified area of the screen so you always see the text being
read and highlights words as they are spoken.
Mouse and cursor enhancements help you track the location of the mouse
pointer and cursor on the screen. You can choose from a wide variety of
enhancement styles. MAGic lets you change the color of these
enhancements, apply transparency effects, adjust their size, and more.
Color enhancements let you change how colors display on your screen.
You can create rules that replace one color with another or switch two
colors. You can also apply color tinting, make your screen black-and-white
(monochrome), and invert the brightness and colors of your display.
Other MAGic features track elements of your screen, such as the mouse
pointer, dialog boxes, and so on. The Locator feature provides you with a
way to quickly find and move to different areas of the screen. The MAGic
multi-directional panning system gives you complete control with adjustable
speed, direction, stop and start, and screen navigation controls.
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System Requirements
The recommended system requirements for MAGic are listed below.
Specification

Minimum Requirement

MAGic Professional
and MAGic Pro Scripting
Edition

64-bit Version: All 64-bit versions of
Windows® 7 and Windows Vista®, and
Windows Server® 2008
32-bit Version: All 32-bit versions of
Windows 7 and Windows Vista, Windows
XP Professional, Windows XP Home,
Windows Media Center Edition, Windows
Server 2008, and Windows Server 2003

MAGic Standard

64-bit Version: Windows 7 Home
Premium, Windows Vista Home
Premium, and Windows Vista Home
Basic
32-bit Version: Windows 7 Home
Premium, Windows Vista Home
Premium, Windows Vista Home Basic,
and Windows XP Home

Processor speed

Minimum 1.5 GHz processor for
Windows 7 or Windows Vista
Minimum 450 MHz Pentium® III
processor or equivalent for Windows XP

RAM

Minimum 2 GB for Windows 7 (64-bit)
Minimum 1 GB required for Windows 7
(32-bit) or Windows Vista
Minimum 256 MB RAM (512
recommended) for Windows XP
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Specification

Minimum Requirement

Required hard disk
space

MAGic requires less than 200 MB of hard
disk space for program and settings files.
Additional space is required for the
operating system, other programs, and
the Windows swap file.

Video

256 color graphics
While MAGic will work with 256 colors, it
is recommended that you use high or
true color depth (16-bit color or higher).

Sound

Windows compatible sound card
required for speech option
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Installing MAGic
To install MAGic on your computer, do the following:
1.
Tip:

2.
Note:

Insert your program DVD. The Freedom Scientific Product Setup
dialog box opens.
If your MAGic installation disc does not start automatically, click
the Start button, select Run, and type D:\setup. If your disc
drive is not D, substitute the correct drive letter.
Press ENTER to choose the MAGic Screen Magnification button.
Press ENTER again to choose the MAGic Setup button.
If you are installing Network MAGic, choose the MAGic Network
Setup button instead, and then choose either the client or server
setup.

3.

The MAGic Setup program starts. You will hear the installation speak
the instructions as they appear on your screen. Follow these
instructions to complete the MAGic installation.

4.

After the Setup Wizard starts, you are asked to accept the End User
License Agreement, and then to choose between performing a typical
or custom installation. The typical installation, which is recommended
for most users, installs the most common program features. Use the
custom installation if you want to specify the default location where
MAGic is stored on your hard disk, or if you want to install client or
server components for remote access. This type of installation is
recommended for advanced users.

5.

When the installation is complete, choose FINISH to exit the Setup
Wizard.
If this is a new MAGic installation, the next step is to complete the
activation process. Otherwise, the MAGic Startup Wizard opens. Use
it to configure basic MAGic parameters and install basic training
materials.
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MAGic Startup Wizard
The MAGic Startup Wizard is a helpful tool that lets you configure specific
MAGic parameters, such as the default magnification setting, hot key
assignment, and startup preferences. In addition, you can install basic
training materials. The wizard launches after you install and activate the
software. You can always run it later from the MAGic Help menu by
pressing ALT+H and choosing Startup Wizard.
The Startup Settings that appear when running the wizard let you define if
and how MAGic loads when you start Windows. The options that appear
will vary depending on your operating system.

Startup Settings for Windows Vista or Later
The Startup Settings dialog box contains several check boxes. If you use
the default settings, MAGic will always load and run before and after you
launch Windows. This dialog box contains the following items:
• Select the Start MAGic at the Log On screen check box so that MAGic
loads and starts when the Windows log on screen appears. The check
box is selected by default. If you have Standard user rights, you cannot
change the value of this check box, and MAGic will ignore and not
announce the check box.
• If the Start MAGic after log on for all users check box is selected,
MAGic loads and starts after you log on to Windows. It is cleared by
default. If you have Standard user rights, you cannot change the value
of this check box, and MAGic will ignore and not announce the check
box.
• The Start MAGic after log on for this user combo box lets an
individual control if MAGic starts after he or she logs on to Windows. If
Always is selected, MAGic starts every time the current user logs on.
Always is the default setting value. If Never is selected, MAGic will not
start after the user logs on. If Using the All Users Setting is selected,
then the following can happen: MAGic starts after the user logs on if the
Start MAGic after log on for all users check box is selected, or MAGic
does not start if the same check box is cleared.
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• Select the Run MAGic from System Tray check box to prevent the
MAGic button from appearing in the Windows taskbar, which is located
at the bottom of the screen, with other programs that are currently
running. Instead, the MAGic icon appears in the Windows system tray,
which is located in the bottom right corner of the screen, to indicate that
MAGic is running. Finally, when this check box is selected, the MAGic
icon does not appear in the list of active windows when you press
ALT+TAB. This check box is cleared by default.
• If the Minimize on Startup check box is selected, the MAGic user
interface is minimized when MAGic starts. To open the user interface,
choose the MAGic button in the taskbar, or press MAGic Key+U. This
check box is cleared by default.

Startup Settings for Windows XP
The Startup Settings dialog box contains the following check boxes:
• Select the Run MAGic at Startup check box so that MAGic
automatically launches when you start Windows.
• Select the Run MAGic from System Tray check box to prevent the
MAGic button from appearing in the Windows taskbar, which is located
at the bottom of the screen, with other programs that are currently
running. Instead, the MAGic icon appears in the Windows system tray,
which is located in the bottom right corner of the screen, to indicate that
MAGic is running. Finally, when this check box is selected, the MAGic
icon does not appear in the list of active windows when you press
ALT+TAB. This check box is cleared by default.
• If the Minimize on Startup check box is selected, the MAGic user
interface is minimized when MAGic starts. To open the user interface,
choose the MAGic button in the taskbar, or press MAGic Key+U. This
check box is cleared by default.

Installing RealSpeak Solo Direct Synthesizers
Included on the program DVD is the RealSpeak Solo Direct speech
synthesizer. It contains a variety of voices in several languages. To install
these voices, insert the DVD into your computer's disc drive. Then, follow
the instructions to select which voices you want to install, and complete the
installation.
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You can also use the RealSpeak Solo Direct Sample and Download page
at http://www.freedomscientific.com/downloads/RealSpeak-SoloDirect-Voices/RealSpeak-Solo-Direct-Downloads.asp. On this page,
you can listen to a voice sample, and, if you like it, download and install the
voice directly from the Web page.

Starting MAGic
MAGic gives you a variety of ways to start the program.
• Press the hot key, ALT+CTRL+M, which can be automatically assigned
from the MAGic Startup Wizard.
• Double-click the MAGic icon on your desktop.
• From the Start menu, choose All Programs, open the MAGic
submenu, and choose MAGic.
• From the Start menu, choose Run, type magicx, where x is the version
number, and press ENTER.

Quitting MAGic
To quit MAGic, do one of the following:
• Press ALT+F4
• Click the Close button

in the top right hand corner of the window.

• Select Exit from the File menu.
Tip:

If you want MAGic to ask you to save your settings when you
quit, open the File menu and choose Preferences. Select the
Prompt to Save Settings on Exit check box.

Getting Started
Start MAGic by pressing ALT+CTRL+M or by double-clicking the MAGic
program icon on your Windows desktop. You can also start MAGic by
opening the Start menu, choosing All Programs, MAGic and then
selecting MAGic.
Tip:

You can change how and when MAGic starts by opening the
File menu and choosing Preferences.
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When you first start MAGic, your screen is displayed in 2× magnification
using the Full view. Speech will also be enabled. You can change the
magnification level, magnified view, speech, and many other options by
using the MAGic user interface.
The user interface is a small window that appears in approximately the
center of your display. This window allows you to control all aspects of
MAGic and contains the magnification and speech buttons in addition to the
MAGic menu and title bars. The user interface is shown below.

Magnification and Speech Buttons
One of the first things you will notice about the user interface is the rows of
blue and orange buttons. The blue buttons control magnification features
while the orange buttons control speech. Below are brief descriptions of
each button.
Button

Function
Use the Magnification button to enable or disable
magnification.
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Button

Function
The current magnification level can be adjusted with
the two Magnification Level buttons. The number
that appears between the two buttons shows the
current level.
Use the Mouse Enhancements button to
enable/disable enhancements and modifications for
your mouse pointer. These enhancements make the
mouse pointer easier to track and maneuver on your
screen.
Use the Cursor Enhancements button to
enable/disable enhancements for your cursor. These
enhancements make the cursor easier to follow when
editing or writing text.
Use the Colors Enhancements button to
enable/disable color enhancements. This feature
allows you to replace colors, adjust the brightness
and contrast, apply tinting, blend colors, and invert
the brightness and colors of your display.
Use the Locator button to enable/disable the Locator
function. The Locator function allows you to find
items on your screen.
Use the Focus Enhancements button to
enable/disable the Focus Enhancements function.
This function places a rectangular border around the
item that is currently selected on your monitor.
The Resize View button allows you to change the
dimensions of your magnified view.
Select your preferred magnified view from the
Magnified Views list.
Use the Speech button to enable or disable speech.
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Button

Function
Use the Mouse Echo button to toggle the mouse
echo feature on and off. The mouse echo feature
enables MAGic to read text that you point at with the
mouse.
Use the Typing Echo button to enable or disable the
typing echo. If typing echo is enabled, MAGic
announces the words or characters you type.
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MAGic Menus
Located above these buttons is the menu bar. The menu bar allows you to
customize speech, magnification, and your keyboard. You can also view
help information and perform other functions. Each menu is described
below.

Menu

Purpose

File

The File menu allows you to save your settings,
restore the original Freedom Scientific settings, and
change your MAGic preferences.

Magnification

The Magnification menu allows you to customize
how you view your screen with MAGic. You can
also change mouse options, panning settings, view
properties and more.

Speech

You can customize MAGic’s speech components to
fit your particular needs. The Speech menu allows
you to customize how you hear MAGic.

Tools

The Tools menu lets you customize keystrokes for
MAGic and configure how MAGic pronounces
specific words. You can also access the Freedom
Scientific Script Manager application from this
menu.
(Note: Requires MAGic Pro Scripting Edition.)

Help

The Help menu provides you with detailed help
information for the various MAGic functions and
options. You can also view information on the
newest features for this release and see your
current MAGic version.
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The MAGic Key
The MAGic Key is the CAPS LOCK key on your keyboard. Pressing the
MAGic Key in combination with other keys activates a number of MAGic
commands. If you want to assign the MAGic Key to a different key on your
keyboard, open the Tools menu, choose Keyboard Manager, and then
choose MAGic Key.

Reading Text with MAGic
MAGic can use synthesized speech to read text that appears on your
screen, including documents, menus, dialog boxes, e-mail messages, Web
pages, and more. Additionally, MAGic can highlight the text as it is spoken.
To customize MAGic’s speech, use the commands available on the
Speech menu.
Tip:

You can silence MAGic’s speech at any time by pressing CTRL.
To toggle speech on or off, press MAGic Key+F3.

Using the Mouse to Read Text
Mouse echo is a feature that allows you to read text with your mouse. To
use mouse echo, just move your mouse pointer to some text on your
screen and then stop. After a short delay, MAGic will speak the word you
pointed to. You can use the Mouse Echo button to enable or disable this
feature.
In addition, you can hold down the MAGic Key and press the left mouse
button to start reading from the current location of the mouse pointer. You
do not need to hold down the MAGic Key while MAGic reads. MAGic stops
reading when you move the mouse or press a key.

Using the Keyboard to Read Text
MAGic has a number of different keystrokes that let you use the keyboard
to read text. To use these keystrokes, move the insertion point or mouse
pointer to any location within the document. Then press one of the following
key combinations to read from that location:
• To begin reading from your current location, press MAGic
Key+SPACEBAR or INSERT+DOWN ARROW.
• To read the current character, press NUM PAD 5.
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• To read the current word, press MAGic Key+ALT or INSERT+NUM
PAD 5. To spell the current word, press the keystroke twice quickly.
• To read the next word, press INSERT+RIGHT ARROW. To read the
previous word, press INSERT+LEFT ARROW.
• To read the current line, press MAGic Key+L or INSERT+UP ARROW.
To read the next line, press DOWN ARROW. To read the previous line,
press UP ARROW.
• To read from the beginning of the line to the current position of the
cursor, press INSERT+HOME. To read from the current position of the
cursor to the end of the line, press INSERT+PAGE UP.
• To read the current sentence, press MAGic Key+S. To read the next
sentence, press CTRL+MAGic Key+S.
• To read the current paragraph, press MAGic Key+P. To read the next
paragraph, press CTRL+MAGic Key+P. To read the previous
paragraph, press ALT+MAGic Key+P.
• To begin reading a column of text from your current location, press
MAGic Key+C.
• To read text that you have selected, press MAGic Key+CTRL or
INSERT+SHIFT+DOWN ARROW.
• To hear the contents of the Clipboard, press MAGic Key+X.
Note:

By default, the MAGic Key is assigned to the CAPS LOCK key.
To change this, open the Tools menu, choose Keyboard
Manager, and then choose the MAGic Key button.

When you read text with these keystrokes, MAGic highlights the word it is
currently speaking. To change the color and/or style of this highlighting,
open the Speech menu and choose Highlight Options.

Reading Text in Dialog Boxes
In addition to the reading commands listed previously, you can use the
following keystrokes to hear information in Windows dialog boxes:
• To read the title bar of the active window or dialog box, press MAGic
Key+T or INSERT+T.
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• To read the bottom of the active window (which usually contains the
status bar), press INSERT+PAGE DOWN. To read the top line of the
active window (which usually contains the title bar), press
INSERT+END.
• To hear the name of the default button that will be activated when you
press ENTER, press INSERT+E.
• To read the currently selected dialog box option (such as an edit box or
check box), press MAGic Key+TAB or INSERT+TAB.
• To hear the access key for the currently selected dialog box option,
press SHIFT+NUM PAD 5.

Getting Help
Online Help System
To access MAGic’s online help system, select Help Topics from the Help
menu, which is located on the menu bar of the MAGic application window.
Use the Contents tab to navigate the help system. Use the Index or the
Search tabs to search for specific topics within the help system. If you want
MAGic to read the help topics to you, position the mouse pointer toward the
beginning of the help page, and press MAGic Key+SPACEBAR. You can
move to the next topic by clicking the "Next" link at the bottom of the page.
To return to the previous topic, click the "Back" link.

What’s This? Help
MAGic’s What’s This? help is context-sensitive help that you can use as a
reference when working with MAGic’s user interface or dialog boxes. Press
SHIFT+F1 on any button on the user interface, or control in a dialog box to
see a brief description of the purpose of the control and how to use it.

MAGic User’s Guide
We provide you with the content of the MAGic online help system in the
MAGic User’s Guide, which is printed in large text for easier reading. This
book contains detailed descriptions of MAGic’s features, and also pull-out
reference cards.
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MAGic Basic Training
Listen to the MAGic Basic Training to learn the fundamentals of using
MAGic Screen Magnification. For more information, see FSReader Demo
and Training Materials on page 15.

Technical Support
If you do not find the answers to questions or problems that you have,
contact Freedom Scientific Technical Support, (727) 803-8600.

About MAGic
Select About MAGic from the Help menu on the MAGic user interface to
view the version number of MAGic you are currently running.

FSReader Demo and Training Materials
The MAGic program disc includes basic training materials in a digital
document format known as DAISY (Digital Accessible Information System).
You can listen to and read the training modules by using the FSReader
Demo (a demonstration version of Freedom Scientific’s DAISY reader),
which is automatically installed with MAGic. By default, at least one DAISY
book (FSGettingStarted) is also installed.

Installing Training Materials When Installing
MAGic
After initially installing MAGic from the MAGic product disc, the MAGic
Startup Wizard launches and prompts you to install training materials,
which consists of two DAISY books (MAGic Basic Training and What’s
New). To install these books, select the Install Training Materials check
box, choose NEXT, and follow the remaining on-screen directions.
Note:

There is an entire series of training and tutorial DAISY books
available for Web download from Freedom Scientific. Use the
Check for Updates function, as described in the following
section, to select and download additional DAISY books, or visit
the Training Web page on the Freedom Scientific Web site.
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Installing Training Materials Later
If you decide not to install training materials during the initial product
installation, you can always use Check for Updates to select, download,
and install training files later. To install training materials, do the following:
1.

Press ALT+CTRL+M to open the MAGic application window.

2.

Press ALT+H to choose the Help menu, and the press P to choose
Check for Updates.

3.

MAGic searches for and then displays a list of DAISY books available
to download. Use the arrow keys to move through the list, and press
the SPACEBAR to select the check box next to each book that you
want to download and install. You can choose the Details button to
view more information about the currently selected book.

4.

Choose the Install button to receive the selected books.

5.

When complete, a dialog box opens announcing that files were
successfully installed. It also states which files were installed. Press
ENTER to close the dialog box. Open FSReader Demo to read these
books.

Starting and Using FSReader Demo
Do the following to start FSReader Demo from the MAGic dialog:
1.

Press ALT+H, T. The Open dialog appears.

2.

Select a DAISY book from the Open dialog, and choose the Open
button. The selected book appears in FSReader.

3.

Press CTRL+P to begin reading the book. Press CTRL+P again to
pause reading the book. To fast forward five seconds, press
CTRL+PERIOD. To rewind the book five seconds, press
CTRL+COMMA.

Note:
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As long as FSReader Demo is running, CTRL+P will toggle
between play and pause. If you want to print while FSReader
Demo is active, you must use an application’s Print command.

4.

When you are finished reading the book, press ALT+F, O to open
another DAISY book, or press ALT+F, X to close and exit FSReader
Demo.

Updating MAGic
Freedom Scientific is continually seeking to improve and expand MAGic for
Windows. Periodically, updates to MAGic will be released. It is
recommended that you keep your software up-to-date so that you
experience the greatest possible performance. In addition, Freedom
Scientific will also provide new and updated DAISY training materials for
you to download.
Updating your software is quick and easy. To search for updates to MAGic
or new training materials, do the following:
Note:

Your computer must be running Windows XP or later, and it
must be able to access the Internet in order to use the following
update procedure.

1.

Press ALT+CTRL+M to open the MAGic application window.

2.

Press ALT+H to open the Help menu.

3.

Press P to select Check for Updates. The update feature determines
if you have the most current release. If you do not, select one or more
items from the list and then select INSTALL to begin the update. All
enhancements since the initial public beta release are included in the
update. If the updates are not installed successfully, repair your
installation of MAGic (refer to the online help for more information)
and then try the procedure again.

Note:

If your computer has active firewall software (such as Windows
Firewall), you may receive a warning indicating that either the
FSAutoUpdate Application or FSAutoUpdate.exe is attempting
to access the Internet. You must allow this process to access
the Internet through the firewall in order to retrieve updates.
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MAGic Keystrokes
Note:

By default, the MAGic Key is the CAPS LOCK key on your
keyboard.

General
Description

General Keystrokes

Start MAGic

CTRL+ALT+M (default
keystroke – can be changed
using the Startup Wizard)

Run Script Manager
(MAGic Pro Scripting Edition
only)

INSERT+0

Minimize/Restore the MAGic
User Interface

MAGic Key+U

Pass Through Key

MAGic Key+3

Refresh Screen

MAGic Key+ESC

Open MAGic Context Menu

MAGic Key+APPLICATION
Key or MAGic Key+RIGHT
MOUSE BUTTON CLICK

Magnification, Views, and Enhancements
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Description

Magnification, Views, and
Enhancements Keystrokes

Increase Magnification

MAGic Key+NUM PAD PLUS
or CTRL+EQUALS or MOUSE
WHEEL UP (scroll wheel up or
away from you)

Description

Magnification, Views, and
Enhancements Keystrokes

Decrease Magnification

MAGic Key+NUM PAD MINUS
or CTRL+DASH or MOUSE
WHEEL DOWN (scroll wheel
down or towards you)

Magnification Toggle On/Off

MAGic Key+DELETE

Toggle between 1x
Magnification and Current
Magnification

MAGic Key+SHIFT+DELETE or
MAGic Key+MOUSE MIDDLE
CLICK (press down on scroll
wheel)

Switch to Next Magnified View

MAGic Key+NUM PAD SLASH

Switch to Previous Magnified
View

MAGic Key+SHIFT+NUM PAD
SLASH

Toggle Color Enhancements
On/Off

MAGic Key+F12

Toggle Cursor Enhancements
On/Off

MAGic Key+F8

Toggle Mouse Enhancements
On/Off

MAGic Key+F4

Panning and Screen Movement
Description

Panning and Screen
Movement Keystrokes

Pan Right

MAGic Key+RIGHT ARROW

Pan Left

MAGic Key+LEFT ARROW

Pan Down

MAGic Key+DOWN ARROW

Pan Up

MAGic Key+UP ARROW
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Description

Panning and Screen
Movement Keystrokes

Increase Speed during Panning

NUM PAD PLUS

Decrease Speed during
Panning

NUM PAD MINUS

Move to Left Edge of Screen in
Magnified View

MAGic Key+HOME

Move to Right Edge of Screen in
Magnified View

MAGic Key+END

Move to top of Screen

MAGic Key+PAGE UP

Move to Bottom of Screen

MAGic Key+PAGE DOWN

Move to Beginning of Next Line

MAGic Key+ENTER

Tracking
Description

Tracking Keystrokes

Tracking Toggle On/Off

MAGic Key+R

Move View to Mouse Pointer

MAGic Key+NUM PAD 5

Move View to Cursor

SHIFT+MAGic Key+NUM PAD
5

Tether Mouse to Display

CTRL+INSERT+NUM PAD
MINUS

Cursor Movement
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Description

Cursor Movement Keystrokes

Route Cursor to Mouse

INSERT+NUM PAD PLUS

Description

Cursor Movement Keystrokes

Route Mouse to Cursor

INSERT+NUM PAD MINUS

Locator Mode
Description

Locator Mode Keystrokes

Start Locator

MAGic Key+F10

Stop Locator and Move to
Selected Area

ENTER

Stop Locator without Moving the
Magnified Area

ESC

Move Left

LEFT ARROW

Move Right

RIGHT ARROW

Move Up

UP ARROW

Move Down

DOWN ARROW

Move to End of Line

END

Move to Beginning of Line

HOME

Move to Top of Screen

PAGE UP

Move to Bottom of Screen

PAGE DOWN

Quick View Frame
Description

Quick View Frame Keystrokes

Toggle Quick View Frame
On/Off

MAGic Key+Q

Set upper left corner of frame

MAGic Key+LEFT BRACKET
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Description

Quick View Frame Keystrokes

Set lower right corner of frame

MAGic Key+RIGHT BRACKET

Create frame around current
dialog box option

MAGic Key+LEFT BRACKET
twice quickly

Open Quick View Manager

MAGic Key+9

Speech
Description

Speech Keystrokes

Silence Current Speech

CTRL

Enable/Disable Speech

MAGic Key+F3

Voice Profiles

MAGic Key+F11

Set Screen Echo

INSERT+S

Select Verbosity Scheme

INSERT+ALT+S

Document and Text Reading
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Description

Document and Text Reading
Keystrokes

Read All from Location (Say All)

INSERT+DOWN ARROW or
MAGic Key+LEFT MOUSE
BUTTON CLICK or MAGic
Key+SPACEBAR

Alternate Say All

INSERT+ALT+DOWN ARROW
or MAGic Key+ALT+LEFT
MOUSE BUTTON CLICK or
MAGic Key+ALT+SPACEBAR

Description

Document and Text Reading
Keystrokes

Read Active Window (reads
from the beginning of document
window)

MAGic Key+SPACEBAR
(twice) or INSERT+DOWN
ARROW (twice)

Say Currently Selected Text

MAGic Key+CTRL or
INSERT+SHIFT+DOWN
ARROW

Say Current Character

NUM PAD 5

Say Current Word

MAGic Key+ALT or
INSERT+NUM PAD 5

Spell Current Word

MAGic Key+ALT (twice) or
INSERT+NUM PAD 5 (twice)

Next Word

INSERT+RIGHT ARROW

Prior Word

INSERT+LEFT ARROW

Select Next Word

INSERT+SHIFT+RIGHT
ARROW

Select Prior Word

INSERT+SHIFT+LEFT ARROW

Say Current Line

MAGic Key+L or INSERT+UP
ARROW

Next Line

DOWN ARROW

Prior Line

UP ARROW

Read to Cursor

INSERT+HOME

Read from Cursor

INSERT+PAGE UP

Say Current Sentence

MAGic Key+S

Next Sentence

MAGic Key+CTRL+S
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Description

Document and Text Reading
Keystrokes

Say Current Paragraph

MAGic Key+P

Read Column from Current
Position

MAGic Key+C

Say Contents of Clipboard

MAGic Key+X

Note:

When using the document and text reading commands, if you
move the mouse MAGic reads from the current location of the
mouse pointer. If you move the insertion point, MAGic reads from
the location of the insertion point.

Dialog Box Reading
Description

Dialog Box Reading
Keystrokes

Say Title Bar

MAGic Key+T or INSERT+T

Read Bottom of Window

INSERT+PAGE DOWN

Say Top Line of Window

INSERT+END

Say Default Button in Dialog
Box

INSERT+E

Say Window Prompt and Text

MAGic Key+TAB or
INSERT+TAB

Say Current Access Key

SHIFT+NUM PAD 5

Table Reading
Description
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Table Reading Keystrokes

Description

Table Reading Keystrokes

Say Current Cell

ALT+CTRL+NUM PAD 5

Cell to Right

ALT+CTRL+RIGHT ARROW

Cell to Left

ALT+CTRL+LEFT ARROW

Cell Below

ALT+CTRL+DOWN ARROW

Cell Above

ALT+CTRL+UP ARROW

First Cell

ALT+CTRL+HOME

Last Cell

ALT+CTRL+END

First Cell in Column

ALT+CTRL+SHIFT+UP
ARROW

Last Cell in Column

ALT+CTRL+SHIFT+DOWN
ARROW

First Cell in Row

ALT+CTRL+SHIFT+LEFT
ARROW

Last Cell in Row

ALT+CTRL+SHIFT+RIGHT
ARROW

Typing Echo
Description

Typing Echo Keystrokes

Cycle through Indicate
Capitalization options

MAGic Key+F2

Cycle through Typing Echo Unit
options

INSERT+2
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Mouse Echo
Description

Mouse Echo Keystrokes

Mouse Echo Toggle

MAGic Key+M

Note:

Toggling the mouse echo rotates between speak lines, speak
words, and mouse echo off.

Some actions in MAGic do not have hot keys assigned. You can define hot
keys for these features from within the Keyboard Manager dialog box.
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Windows Shortcut Keys
General
Description

General Shortcut Keys

Get Help

F1

Open the Start menu

WINDOWS Key or CTRL+ESC

Open Windows Explorer

WINDOWS Key+E

Open the Run dialog box

WINDOWS Key+R

Find file or folder from Desktop

F3

Minimize all windows

WINDOWS Key+M

Switch between programs

ALT+TAB

Quit the active program

ALT+F4

For Windows and Menus
Description

Windows and Menus Shortcut
Keys

Open the application control
menu

ALT+SPACEBAR

Move to the menu bar

ALT

Choose a menu command

ENTER

Move between menus

ALT, arrow keys

Close a menu

ESC

Close a cascading menu

ALT
27

Description

Windows and Menus Shortcut
Keys

Open a child window control
menu

ALT+HYPHEN

Close a child window

CTRL+F4

Open the context menu

APPLICATION Key or
SHIFT+F10

For Dialog Boxes
Description

Dialog Boxes Shortcut Keys

Move through dialog box
options

TAB

Move backward through dialog
box options

SHIFT+TAB

Move to another tab

CTRL+TAB

Reverse direction through tabs

CTRL+SHIFT+TAB

Move to first option

HOME

Move to last option

END

Select or clear an item in a list

SPACEBAR or
CTRL+SPACEBAR

Select or clear a check box

SPACEBAR

For Reading Text
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Description

Reading Text Shortcut Keys

Move left one character

LEFT ARROW

Description

Reading Text Shortcut Keys

Move right one character

RIGHT ARROW

Move left one word

CTRL+LEFT ARROW

Move right one word

CTRL+RIGHT ARROW

Move to beginning of line

HOME

Move to end of line

END

Move up one paragraph

CTRL+UP ARROW

Move down one paragraph

CTRL+DOWN ARROW

Scroll up one screen

PAGE UP

Scroll down one screen

PAGE DOWN

Move to beginning of document

CTRL+HOME

Move to end of document

CTRL+END

For Editing Text
Description

Editing Text Shortcut Keys

Copy

CTRL+C

Cut

CTRL+X

Paste

CTRL+V

Undo

CTRL+Z

Delete character to the left

BACKSPACE

Delete character to the right

DELETE

Select one character left

SHIFT+LEFT ARROW
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Description

Editing Text Shortcut Keys

Select one character right

SHIFT+RIGHT ARROW

Select one word left

CTRL+SHIFT+LEFT ARROW

Select one word right

CTRL+SHIFT+RIGHT ARROW

Select to beginning of line

SHIFT+HOME

Select to end of line

SHIFT+END

Select to beginning of document

CTRL+SHIFT+HOME

Select to end of document

CTRL+SHIFT+END

Select all

CTRL+A

For Windows Explorer
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Description

Windows Explorer Shortcut
Keys

Rename selected file or folder

F2

Open properties

ALT+ENTER

Refresh a window

F5

Switch between panes

F6 or TAB

Go up a level

BACKSPACE

